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ix

Electronic spreadsheets have been available for microcomputers since the introduction of VisiCalc® 
for the Apple I in June 1979. The first version of Lotus 1-2-3® in January 1983 convinced businesses 
that the IBM PC was a truly useful productivity-enhancing tool. Today, any student who leaves 
business school without at least basic spreadsheet skills is truly at a disadvantage. Much as earlier 
generations had to be adept at using a slide rule or financial calculator, today’s manager needs to be 
proficient in the use of a spreadsheet. International competition means that companies must be as 
efficient as possible. No longer can managers count on having a large staff of “number crunchers” at 
their disposal.

Microsoft first introduced Excel in 1985 for the Apple Macintosh and showed the world that spread-
sheets could be both powerful and easy to use, not to mention fun. Excel 2.0 was introduced to the 
PC world in 1987 for Microsoft Windows version 1.0, where it enjoyed something of a cult following. 
With the introduction of version 3.0 of Windows, sales of Excel exploded so that today it is the lead-
ing spreadsheet on the market. 

As of this writing, Excel for Office 365 (also known as Excel version 16) is the current version. 
Unlike Excel 2007, which introduced the Ribbon interface, there are no dramatic visual changes in 
the current version. However, the new calculation engine, and the way that it treats array formulas, is 
an important difference from older versions (see page 24 in Chapter 1). There are also several new 
and very useful array functions that have been introduced alongside the new calculation engine. 
While the book has been written with the current version in mind, it can be used with older ver-
sions, if allowances are made for minor interface differences.

The user interface is somewhat different on the Apple Mac, but Excel for Office 365 for Mac sup-
ports nearly all of the features discussed in this book. The major missing features are pivot charts 
and the Get & Transform tools. Both of those features are used in Chapter 16, but Get & Transform 
is also used in Chapter 10 to get yield curve data from the U.S. Treasury Web site. Mac users can 
access the yield curve data by using the From Web tool in Get External Data instead. Microsoft has 
recently promised that the Get & Transform tools will be available on Mac at some point, though 
there is no estimated time of arrival. There are still issues with Excel add-ins that make use of user-
forms on the Mac version as of this writing. I have made a document, Fame 9e Guide for Mac Users.
pdf, that is available on the official support Web site. 

Purpose of the Book

Financial Analysis with Microsoft Excel, 9th ed. was written to demonstrate useful spreadsheet tech-
niques and tools in a financial context. This allows readers to see the material in a way with which 
they are familiar. For students just beginning their education in finance, the book provides a thor-
ough explanation of all of the concepts and equations that are usually covered. In other words, it is 
a corporate finance textbook, but it uses Excel instead of financial calculators.

Preface
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Students with no prior experience with spreadsheets will find that using Excel is very intuitive, 
especially if they have used other Windows applications. For these students, Financial Analysis with 

Microsoft Excel, 9th ed. will provide a thorough introduction to the use of spreadsheets from basic 
screen navigation skills to building fairly complex financial models. I have found that even students 
with good spreadsheet skills have learned a great deal more about using Excel than they expected.

Finally, I feel strongly that providing pre-built spreadsheet templates for students to use is a disser-
vice. For this reason, this book concentrates on spreadsheet building skills. I believe that students 
can gain valuable insights and a deeper understanding of financial analysis by actually building their 
own spreadsheets. By creating their own spreadsheets, students will have to confront many issues 
that might otherwise be swept under the carpet. It continually amazes me how thankful students are 
when they are actually forced to think rather than just to “plug and go.” For this reason the book 
concentrates on spreadsheet building skills (though all of the worksheets are provided to instruc-
tors) so that students will be encouraged to think and truly understand the problems on which they 
are working.

Target Audience

Financial Analysis with Microsoft Excel is aimed at a wide variety of students and practitioners of 
finance. The topics covered generally follow those in an introductory financial management course 
for undergraduates or first-year MBA students. Because of the emphasis on spreadsheet building 
skills, the book is also appropriate as a reference for case-oriented courses in which the spreadsheet 
is used extensively. I have been using the book in my Financial Modeling course since 1995, and 
students consistently say that it is the most useful course they have taken. A sizable number of my 
former students have landed jobs due to their superior spreadsheet skills.

I have tried to make the book complete enough that it may also be used for self-paced learning, 
and, if my e-mail is any guide, many have successfully taken this route. I assume, however, that 
the reader has some familiarity with the basic concepts of accounting and statistics. Instructors will 
find that their students can use this book on their own time to learn Excel, thereby minimizing the 
amount of class time required for teaching the basics of spreadsheets. Practitioners will find that the 
book will help them transfer skills from other spreadsheets to Excel and, at the same time, refresh 
their knowledge of corporate finance.

A Note to Students

As I have noted, this book is designed to help you learn finance and understand spreadsheets at the 
same time. Learning finance alone can be a daunting task, but I hope that learning to use Excel at 
the same time will make your job easier and more fun. Be sure to experiment with the examples by 
changing numbers and creating charts.

Copyright 2021 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s).

Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Copyright 2021 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part.  WCN 02-200-322



Preface

xi

You will likely find that learning the material and skills presented is more difficult if you do not work 
the examples presented in each chapter. While this will be somewhat time consuming, I encourage 
you to work along with, rather than just read, the book as each example is discussed. Further, I sug-
gest that you try to avoid the trap of memorizing Excel formulas. Instead, try to understand the logic 
of the formula so that you can more easily apply it in other, slightly different, situations in the future.

Organization of the Book

Financial Analysis with Microsoft Excel, 9th ed. is organized along the lines of an introductory finan-
cial management textbook. The book can stand alone or be used as an adjunct to a regular text, 
but it is not “just a spreadsheet book,” and shouldn’t be treated as a cookbook with recipes. In most 
cases topics are covered at the same depth as the material in conventional textbooks; in many cases 
the topics are covered in greater depth. For this reason, I believe that Financial Analysis with Micro-

soft Excel, 9th ed. can be used as a comprehensive primary text. The book is organized as follows:

• Chapter 1: Introduction to Excel

• Chapter 2: The Basic Financial Statements

• Chapter 3: Financial Statement Analysis Tools

• Chapter 4: The Cash Budget

• Chapter 5: Financial Statement Forecasting

• Chapter 6: Forecasting Sales with Time Series Methods

• Chapter 7: Break-Even and Leverage Analysis

• Chapter 8: The Time Value of Money

• Chapter 9: Common Stock Valuation

• Chapter 10: Bond Valuation

• Chapter 11: The Cost of Capital

• Chapter 12: Capital Budgeting

• Chapter 13: Risk and Capital Budgeting

• Chapter 14: Portfolio Statistics and Diversification

• Chapter 15: Writing User-Defined Functions with VBA

• Chapter 16: Analyzing Datasets with Tables and Pivot Tables

• Appendix: Directory of User-Defined Functions in FameFncs.xlam

Extensive use of built-in functions, charts, and other tools (e.g., Scenario Manager and Solver) 
throughout the book encourages a much deeper exploration of the models presented than do more 
traditional methods. Questions such as, “What would happen if...” are easily answered with the tools 
and techniques taught in this book.
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Outstanding Features

The most outstanding feature of Financial Analysis with Microsoft Excel, 9th ed. is its use of Excel 
as a learning tool rather than just a fancy calculator. Students using the book will be able to demon-
strate to themselves how and why things are the way they are. Once students create a worksheet, 
they understand how it works and the assumptions behind the calculations. Thus, unlike the tradi-
tional “template” approach, students gain a deeper understanding of the material. In addition, the 
book greatly facilitates the professors’ use of spreadsheets in their courses.

The text takes a self-teaching approach used by many other “how-to” spreadsheet books, but it 
provides opportunities for much more in-depth experimentation than the competition. For example, 
scenario analysis is an often recommended technique, but it is rarely demonstrated in any depth. 
This book uses the tools that are built into Excel to greatly simplify computation-intensive tech-
niques, eliminating the boredom of tedious calculation. Other examples include regression analysis, 
linear and nonlinear programming, and Monte Carlo simulation. The book encourages students to 
actually use the tools that they have learned about in their statistics and management science classes.

Pedagogical Features

Financial Analysis with Microsoft Excel, 9th ed. begins by teaching the basics of Excel. Then, the 
text uses Excel to build the basic financial statements that students encounter in all levels of financial 
management courses. This coverage then acts as a “springboard” into more advanced material such 
as performance evaluation, forecasting, valuation, capital budgeting, and modern portfolio theory. 
Each chapter builds upon the techniques learned in prior chapters so that the student becomes 
familiar with Excel and finance at the same time. This type of approach facilitates the professor’s 
incorporation of Excel into a financial management course since it reduces, or eliminates, the neces-
sity of teaching spreadsheet usage in class. It also helps students to see how this vital “tool” is used 
to solve the financial problems faced by practitioners.

The chapters are organized so that a problem is introduced, solved by traditional methods, and then 
solved using Excel. I believe that this approach relieves much of the quantitative complexity while 
enhancing student understanding through repetition and experimentation.

This approach also generates interest in the subject matter that a traditional lecture cannot (espe-
cially for nonfinance business majors who are required to take a course in financial management). 
Once they are familiar with Excel, my students typically enjoy using it and spend more time with the 
subject than they otherwise would. In addition, since charts are used extensively (and are created by 
the student), the material may be better retained.

A list of learning objectives precedes each chapter, and a summary of the major Excel functions 
discussed in the chapter is included at the end. In addition, each chapter contains homework prob-
lems, and many include Internet Exercises that introduce students to sources of information on the 
Internet.
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Supplements

The Instructor’s Manual and other resources, available online, contain the following:

(These materials are available to registered instructors at the product support Web site, www.cengage.com.)

• The completed worksheets with solutions to all problems covered in the text. Having this 
material allows the instructor to easily create transparencies or give live demonstrations via 
computer projections in class without having to build the spreadsheets from scratch.

• A set of PowerPoint slides for each chapter.

• Additional Excel spreadsheet problems for each chapter that relate directly to the concepts cov-
ered in that chapter. Each problem requires the student to build a worksheet to solve a common 
financial management problem. Often the problems require solutions in a graphical format.

• Complete solutions to the in-text homework problems and those in the Instructor’s Manual and 
on the product Web site, along with clarifying notes on techniques used.

• An Excel add-in program that contains some functions that simplify complex calculations such 
as the two-stage common stock valuation model and the payback period, among many others 
(see the Appendix for a complete listing of the functions). Also included is an add-in program 
for performing Monte-Carlo simulations discussed extensively in Chapter 13, and an add-in to 
create “live” variance/covariance matrices. These add-ins are available on the Web site.

Typography Conventions

The main text of this book is set in the 10-point Times New Roman True Type font. Text or numbers 
that readers are expected to enter are set in the 10 point Courier New True Type font.

The names of built-in functions are set in small caps and boldface. Function arguments can be either 
required or optional. Required inputs are set in small caps and are italicized and boldface. Optional 
inputs are set in small caps and italicized. As an example, consider the PV function (introduced in 
Chapter 8):

PV(RATE, NPER, PMT, FV, TYPE)

In this example, PV is the name of the function, RATE, NPER, and PMT, are the required arguments, 
while FV and TYPE are optional.

In equations and the text, equation variables (which are distinct from function arguments) are itali-
cized. As an example, consider the PV equation:

             FVN
PV 5 _______
          (1 1 i)N

I hope that these conventions will help avoid confusion due to similar terms being used in different 
contexts.
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Changes from the 8th Edition

The overall organization of the book remains the same, but there have been many changes through-
out the book. All of the chapters have been updated, but the more important changes include the 
following:

Chapter 1 has been updated for Excel as of late 2019, including a new section that covers array for-
mulas. We have always used some array formulas in past editions, but there was never one section 
that introduced them properly.

Throughout the book, every chapter has been updated to some extent at least to correct any errors. 
In those chapters that make use of real world data, that data has been updated to current data as of 
mid-2019. Also, in several cases we mention some of the new dynamic array functions that are cur-
rently available only to Office Insiders (e.g., Filter, XLookup, etc.). These new functions are expected 
to be released to all Office 365 subscribers by the end of 2019. It should be noted that those who 
purchased the perpetually licensed Excel 2019 will never get these functions or the new calculation 
engine that enables them. This is a good reason subscribe to Office 365.

In addition, in order to reflect the lower corporate tax rates due to the Tax Cuts and Jobs Act of 
2017, I have changed the tax rate used throughout the book to 25%. This is intended to be the 21% 
federal flat tax rate plus 4% for a state tax rate. Obviously, state tax rates vary, but using 4% gives us 
a nice round number for example purposes.

A Note on the Internet

I have tried to incorporate Internet Exercises into those chapters where the use of the Internet is 
applicable. In many cases, the necessary data simply is not available to the public or very difficult 
to obtain on-line (e.g., cash budgeting), so some chapters do not have Internet Exercises. For those 
chapters that do, I have tried to describe the steps necessary to obtain the data—primarily from 
either the SEC’s Edgar System or Yahoo! Finance. It should be noted that Web sites change frequently 
and these instructions and URLs may change in the future. I chose the Edgar System and Yahoo! 
Finance because I believe that these sites are the least likely to undergo severe changes and/or dis-
appear completely. In many cases, there are alternative sites from which the data can be obtained if 
it is no longer available from the given site. All Excel spreadsheets for students’ and instructors’ use 
(as referenced in the book) are available at the product support Web site https://www.cengage.com 
/finance/mayes/analysis/9e.
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1

L E A R N I N G  O B J E C T I V E S :  After studying this chapter, you should be able to:

LO1 
Explain the basic purpose of a spreadsheet 

program.

LO2 
Identify the various components of the Excel 

screen.

LO3 
Navigate the Excel worksheet (entering, 

correcting, and moving data within the 

worksheet).

LO4 
Explain the purpose and usage of Excel’s built-in 

functions and user-defined functions.

LO5 
Create graphics and know how to print and save 

files in Excel.

Introduction to Excel

C H A P T E R

1

The term “spreadsheet” covers a wide variety of elements useful for quantitative anal-
ysis of all kinds. Essentially, a spreadsheet is a simple tool consisting of a matrix of 
cells that can store numbers, text, or formulas. The spreadsheet’s power comes from 
its ability to recalculate results as you change the contents of other cells. No longer 
does the user need to do these calculations by hand or on a calculator. Instead, with 
a properly constructed spreadsheet, changing a single number (say, a sales forecast) 
can result in literally thousands of automatic changes in the model. The freedom and 
productivity enhancement provided by modern spreadsheets presents an unparalleled 
opportunity for learning financial analysis.
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Spreadsheet Uses

Spreadsheets today contain built-in analytical capabilities previously unavailable in a 
 single package. Years ago, users often had to learn a variety of specialized software pack-
ages to do any relatively complex analysis. With the newest versions of Microsoft Excel, 
users can perform tasks ranging from the routine maintenance of financial statements to 
multivariate regression analysis to Monte Carlo simulations of hedging strategies.

It is impossible to enumerate all of the possible applications for spreadsheets. You 
should keep in mind that spreadsheets are useful not only for financial analysis but 
also for any type of quantitative analysis whether your specialty is in marketing, man-
agement, engineering, statistics, or economics. For that matter, a spreadsheet can also 
prove valuable for personal uses. With Excel, it is a fairly simple matter to build a 
spreadsheet to monitor your investment portfolio, plan for retirement, experiment 
with various mortgage options when buying a house, create and maintain a mailing 
list, and so on. The possibilities are quite literally endless. The more comfortable you 
become with the spreadsheet, the more uses you will find. Using a spreadsheet can 
help you find solutions that you never would have imagined on your own. Above all, 
feel free to experiment and try new things as you gain more experience working with 
spreadsheet programs, particularly Excel.

The above is not meant to suggest that Excel is the only analytical tool you’ll ever 
need. For example, Excel is not meant to be a relational database, though it has some 
tools that allow it to work well for small databases (see Chapter 16). For bigger proj-
ects, however, Excel can serve as a very effective “front-end” interface to a database. 
It also isn’t a complete replacement for a dedicated statistics program, though it can 
work well for many statistical problems. Although Excel can be made to do just about 
anything, it isn’t always the best tool for the job. Still, it may well be the best tool that 
you or your colleagues know how to use.

Starting Microsoft Excel

Start Excel by double-clicking on the program’s icon. The location of the Excel icon 
will depend on the organization of your system. You may already have the Excel icon 
(at left) on the desktop or in the taskbar. Otherwise, you can start Excel by clicking 
the Start button and then clicking the Excel tile, or type Excel into the search box 
in the taskbar. If you have Windows 10 and a microphone, then you can even tell 
 Cortana to “start Excel.”

For easier access, you may wish to create a Desktop or Taskbar shortcut. To do this, 
click on the Excel icon in the Start menu and drag the icon to the Desktop or Taskbar. 
Remember that a shortcut is not the program itself, so you can safely delete the short-
cut if you later decide that you no longer need it.

X

Excel Icon
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Parts of the Excel Screen

If you have used any recent version of Excel, then you will be familiar with most of 
the user interface in current version. In Figure 1-1, note the labeled parts of the Excel 
screen. We will examine most of these parts separately. Please refer to Figure 1-1 as 
you read through each of the sections that follow.

FIGURE 1-1 Microsoft Excel

File Tab

{

{

{

Ribbon

Active Cell

Formula Bar
Launch Insert Formula Dialog

Sheet Tab
Scroll Bars

Zoom ControlView ButtonsStatus Bar

Worksheet Area

Search for Help TabsTitle BarQuick Access Toolbar

Name Box

Add New Sheet

Collapse RibbonDialog Box Launcher

Close Button

Record VBA Macro

The File Tab and Quick Access Toolbar

The File tab in Excel is similar to the File menu in most other Windows programs. It 
can be opened either by clicking the tab or by pressing Alt-F. Click the File tab when 
you need to open, save, print, or create a new file.

The File tab also contains additional functionality. It opens in what is known as Back-

stage View, which takes over the entire window. This additional space, compared to 
a menu, allows for much more information to be displayed. For example, if you click 
the Print tab on the left side you get access not only to all of the print settings but also 
to print preview on the same page. The Info tab is where you can set the document 
properties (author, keywords, etc.), inspect the document for hidden data that may 
reveal private details, encrypt the spreadsheet, and so on.
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Finally, the File tab is the pathway to setting the program options. At the bottom of 
the tabs on the left you will find a link to Options. This launches the Excel Options 
dialog box where you can set all of the available options. It is advisable to go through 
the Excel Options to familiarize yourself with some of the things that you can control. 
While you may not understand all of the choices, at least you will know where to go 
when you need to change something (e.g., the user name, macro security level, or the 
default file locations).1

You also have the ability to customize the Ribbon. Click the File tab, choose Options, 
and then select Customize Ribbon in the dialog box. Here you can create new tabs, 
move buttons from one tab to another, remove them completely, and even export 
your customizations so that others can use them.

The Quick Access toolbar (often abbreviated as QAT) is located above the File tab 
and, by default, provides a button to save the current file as well as the Undo and 
Redo buttons. If you regularly use commands that aren’t located on the Home tab, 
you can easily customize the Quick Access toolbar to add those commands by right-
clicking the QAT and choosing “Customize Quick Access Toolbar…” The dialog box 
is self-explanatory. You can also add or remove commands, such as Print Preview, by 
clicking the arrow to the right of the QAT.

The Home Tab

1.  If you use Microsoft’s OneDrive, it is advisable to uncheck the option to AutoSave OneDrive and SharePoint 

Online files in the Save options.

FIGURE 1-2 Excel Home Tab

Immediately below the title bar, Excel displays the various tabs in what is known as 
the Ribbon. Tabs are the toolbars that replaced the menus of pre-2007 versions. The 
Home tab contains the most commonly used commands, including the Cut, Copy, and 
Paste buttons, and the various cell formatting buttons. You can learn what function 
each button performs by letting the mouse pointer hover over a button causing a 
message to appear that informs you of the button’s function. This message is known 
as a ToolTip. ToolTips are used frequently by Excel to help you identify the function 
of various items on the screen.
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Note that several of the buttons (e.g., the Copy and Paste buttons) on the Ribbon have 
a downward-pointing arrow. This is a signal that the button has options besides the 
default behavior. For example, by clicking the arrow on the Paste button you will find 
that there are several choices regarding what to paste (e.g., just the formula, or the 
value without the formula, etc.). Clicking the upper half of a split button invokes the 
default purpose.

The other tabs are named according to their functionality, and you will quickly learn 
which one to choose in order to carry out a command. Table 1-1 shows the other tabs 
and a short description of what they do.

Paste

Ta b l e  1 - 1 Other Tabs in the Excel Ribbon

Tab What It Does

File File management features (open, save, close, print, etc.) and options.

Insert Contains buttons for inserting pivot tables, charts, pictures, shapes, text boxes, 

equations, and other objects.

Page Layout Has choices that control the look of the worksheet on the screen and when 

printed. You can change the document theme, the page margins and 

orientation, and so on.

Formulas Used when you want to insert a formula, create a defined name for a cell or 

range, or use the formula auditing tools to find errors.

Data Contains buttons for getting data from other sources (such as an Access 

database, a Web site, or a text file). Launch tools such as the Scenario Manager, 

Goal Seek, Solver, and the Analysis Toolpak.

Review Here you will find spell check, the thesaurus, and also commands for working 

with cell comments and worksheet protection.

View Contains commands that control the worksheet views, zoom controls, and  

the visibility of various objects on the screen (such as gridlines and the 

formula bar).

Developer Has tools that allow you to access the VBA editor, insert controls (e.g., 

dropdown lists), and work with XML. This tab is not visible by default, but can 

be enabled in Options.

Add-ins This is where older Excel add-ins that create custom tool bars and menus will 

be located. Not visible unless older add-ins are installed.

Power Pivot Power Pivot is an add-in for certain versions of Excel. It allows you to work with 

data files that are much larger than Excel can normally handle. 

Note that another set of tabs will appear when you are working on charts. The Chart 
Design and Format tabs contain all of the options that you will need for working 
with charts (see “Creating Graphics” on page 28). Furthermore, add-in programs may 
create additional tabs.
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The Formula Bar

As you work more in Excel to create financial models, you will find that the formula 
bar is one of its most useful features. The formula bar displays information about the 
currently selected cell, which is referred to as the active cell. The left part of the for-
mula bar indicates the name or address of the selected cell (H9 in Figure 1-3). The 
right part of the formula bar displays the contents of the selected cell. If the cell con-
tains a formula, the formula bar displays the formula while the cell itself displays the 
result of the formula. If text or numbers have been entered, then the text or numbers 
are displayed.

FIGURE 1-3 The Formula Bar

H9 =SUM(H2:H8)…

The fx button on the formula bar is used to show the Insert Function dialog box. This 
dialog box helps you to find and enter functions without having to memorize them. 
It works the same as the Insert Function button on the Formulas tab. See page 22 for 
more information.

The chevron at the right of the formula bar is used to expand the formula bar. This is 
useful if you have long formulas that occupy more than one line. You can break long 
formulas across multiple lines by pressing Alt 1 Enter where you want the line to 
break. If you do this, then you can expand the formula bar even further by dragging 
its lower edge. 

The Worksheet Area

The worksheet area is where the real work of the spreadsheet is done. The worksheet 
is a matrix of cells (1,048,576 rows by 16,384 columns),2 each of which can contain text, 
numbers, or formulas. Each cell is referred to by a column letter and a row number. 
Column letters (A, B, C, …, XFD) are listed at the top of each column, and row num-
bers (1, 2, 3, …, 1048576) are listed to the left of each row. The cell in the upper left 
corner of the worksheet is, therefore, referred to as cell A1, the cell immediately below 
A1 is referred to as cell A2, the cell to the right of A1 is cell B1, and so on. This naming 

2.  This is known as the “big grid” because it is much larger than in pre-2007 versions of Excel, which only sup-

ported up to 65,536 rows and 256 columns.
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convention is common to all spreadsheet programs. If not already, you will become 
comfortable with it once you have gained some experience working in Excel.

The active cell can be identified by a solid green border around the cell. Note that the 
active cell is not always visible on the screen, but its address is always shown in the 
leftmost portion of the formula bar. In the lower-right corner is the AutoFill handle 
(see page 11).

Sheet Tabs

FIGURE 1-4 The Sheet Tabs

Sheet1 Sheet2 Sheet3

Excel worksheets are stored in a format that allows you to combine multiple work-
sheets into one file known as a workbook. This allows several related worksheets 
to be contained in one file for easy access. The sheet tabs, near the bottom of the 
screen, enable you to move easily from one sheet to another in a workbook. You 
may rename, copy, or delete any existing sheet or insert a new sheet by right-clicking 
a sheet tab with the mouse and making a choice from the resulting menu. You can 
change the order of the sheet tabs by clicking a tab and dragging it to a new position, 
or you can press the Ctrl key (option on Mac) and drag to copy it. To insert a new 
worksheet, click the New Sheet button to the right of the last worksheet.

It is easy to do any of these operations on multiple worksheets at once, except for 
renaming. Simply click the first sheet and then Ctrl 1 click each of the others. (You 
can select a contiguous group of sheets by selecting the first and then Shift 1 click  
the last.) Now, right-click one of the selected sheets and select the appropriate option 
from the pop-up menu. When sheets are grouped, anything you do to one sheet gets 
done to all. This feature is useful if, for example, you need to enter identical data 
into multiple sheets or need to perform identical formatting on several sheets. To 
ungroup the sheets, either click on any nongrouped sheet or right-click a sheet tab 
and choose Ungroup Sheets from the pop-up menu. Another feature in Excel allows 
you to choose a color for each sheet tab by right-clicking the tab and choosing a Tab 
Color from the pop-up menu.

The transport buttons to the left of the sheet tabs allow you to scroll through the list 
of sheet tabs. Right-clicking either of these buttons will display a pop-up menu that 
allows you to quickly jump to any sheet tab in the workbook. This is especially help-
ful when you have too many tabs for them all to be shown.

Insert…

Delete

Rename

Tab

Hide

Unhide…

Select All Sheets

Ungroup Sheets

Color

View Code

Protect Sheet…

Move or Copy…
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Status Bar

The status bar, located below the sheet tabs, contains information regarding the cur-
rent state of Excel, as well as certain messages. For example, most of the time the only 
message is “Ready” indicating that Excel is waiting for input. At other times, Excel may 
add “Calculate” to the status bar to indicate that it needs to recalculate the worksheet 
due of changes. You can also direct Excel to do certain calculations on the status bar. 
For example, in Figure 1-5, Excel is showing the average, count, and sum of selected 
cells in the worksheet. 

FIGURE 1-5 The Status Bar

Average: 81208Ready Count: 6 Sum: 487248 130%

By right-clicking on this area of the status bar, you can also get Excel to calculate the 
count of numbers only, minimum, or maximum of any highlighted cells. This is useful 
when you need a quick calculation that doesn’t need to be in the worksheet. 

The right side of the status bar contains buttons to change the view of the worksheet 
(normal, page layout, and page break preview) as well as the zoom level.

Navigating the Worksheet

There are two principal ways for moving around within the worksheet area: the 
arrow or tab keys and the mouse. For small distances the arrow keys provide an easy 
method of changing the active cell, but moving to more distant cells is usually easier 
with the mouse.

Most keyboards have a separate keypad containing arrows pointing up, down, left, 
and right. If yours does not, then the numeric keypad can be used if the Num Lock 
function is off. You can use the Tab key to move one cell to the right. The Page Up 
and Page Down keys also work as you would expect.

The mouse is even easier to use. While the mouse pointer is over the worksheet area 
it will be in the shape of a fat cross. To change the active cell move the mouse pointer 
over the destination cell and click. To move to a cell that is not currently displayed 
on the screen, click on the scroll bars until the cell is visible and then click on it. 
For example, if the active cell is A1 and you wish to make A100 the active cell, click 
on the scroll bar on the right hand part of the screen until A100 is visible. Move the 
mouse pointer over cell A100 is visible and then click. Each click on the scroll bar 
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moves the worksheet up or down one page. If you wish to move up, click above the 
thumb. If down, click beneath the thumb. The thumb (or slider) is the button that 
moves up and down the scroll bar to indicate your position in the worksheet. To 
move more quickly, you can drag the thumb to the desired position.

If you know the name or address of the cell to which you wish to move use the Go 
To command. The Go To command will change the active cell to whatever cell you 
indicate. The Go To dialog box can be used by clicking the Find & Select button on 
the Home tab and then choosing the Go To… command, by pressing the F5 function 
key, or by pressing the Ctrl 1 G key combination. To move to cell A50, simply press 
F5, type: A50 in the Reference box, and then press Enter. You will notice that cell A50 
is now highlighted and visible on the screen. You can also use Go To to find certain 
special cells (e.g., the last cell that has data in it) by pressing the Special… button in 
the Go To dialog box.

Selecting a Range of Cells

Many times you will need to select more than one cell at a time. For example, you 
may wish to apply a particular number format to a whole range of cells, or you might 
want to clear a whole range. Because it would be cumbersome to do this one cell at 
a time, especially for a large range, Excel allows you to simultaneously select a whole 
range and perform various functions on all of the cells at once. The easiest way to 
select a contiguous range of cells is to use the mouse. Simply point to the cell in the 
upper left corner of the range, and click and drag the mouse until the entire range is 
highlighted. As you drag the mouse, watch the left side of the formula bar. Excel will 
inform you of the number of selected rows and columns. In addition, the row and 
column headers will be highlighted for the selected cells.

You can also use the keyboard to select a range. First change the active cell to the 
upper left corner of the range to be selected, press and hold down the Shift key, and 
use the arrow keys to highlight the entire range. Note that if you release the Shift key 
while pressing an arrow key you will lose the selection. A very useful keyboard short-
cut is the Shift 1 Ctrl 1 Arrow (any arrow key will work) combination. This is used to 
select all of the cells from the active cell up to, but not including, the first blank cell. 
For example, if you have 100 numbers in a column and need to apply a format, just 
select the first cell and then press Shift 1 Ctrl 1 Down arrow to select them all. This 
is faster and more accurate than using the mouse.

Often it is also useful to select a discontiguous range (i.e., two or more unconnected 
ranges) of cells. To do this, simply select the first range as usual and then hold down 
the Ctrl key as you select the other ranges. 

Find &

Select
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Using Defined Names

A named range is a cell, or group of cells, for which you have supplied a name. 
Named ranges can be useful in a number of different ways, but locating a range on a 
big worksheet is probably the most common use. To name a range of cells, start by 
selecting the range. For example, select A1:C5 and then choose Define Name from the 
Formulas tab. At the top of the New Name dialog box, enter a name, say MyRange 
(note that a range name cannot contain spaces or most special characters). Figure 1-6 
shows how the dialog box should look. Note that the Refers to edit box shows the 
address to which the name refers.3

Define Name

You can also enter a comment that provides more detail about the range and con-
trol the scope of the name. Scope refers to the location within which the name 
doesn’t need to be qualified by a sheet name. For example, MyRange was defined 
to have Workbook scope. Therefore, we can refer to that range from any cell of 
the entire workbook by just using its name (5MyRange). However, if the scope 
had been restricted to Sheet1, then from Sheet2 we would refer to the name with 
5Sheet1! MyRange. Note that defined names must be unique within their scope. So 
you can only have one workbook-scoped range named MyRange, but you could 
have one MyRange per worksheet if it is scoped to the sheet level.

3.  The name is actually defined as a formula. This is important for some of the more advanced uses of named 

ranges. For example, we can use a name to define constants, do calculations, or to create a reference to a range 

that grows as data is added.

FIGURE 1-6 The Define Name Dialog Box

New Name

Name:

Scope:

Comment:

Refers to:

MyRange

?

Workbook

=Sheet1!$A$1:$C$5

This is an example of how to de�ne a range. This one will work throughout
the entire workbook, but you can make them local to a worksheet so that
you can use the same name more than once.

OK Cancel
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Once the range is named, you can select it using the Go To command (Find & Select 
then Go To…, or press F5). The name will appear in the list on the Go To dialog box. 
An even faster method is to use the Name Box on the left side of the formula bar. 
Simply drop the list and choose the named range that you wish to select.

Named ranges can be used in formulas in place of cell addresses and can be used in 
the SERIES function for charts. Defined names don’t have to refer to a cell or range. 
They can be used to define a constant or formula instead. For example, you might 
create the name Pi and in the Refers to box enter: 53.14159 instead of a cell or 
range address. You can use that name in formulas whenever you need the value of Pi, 
though Excel already has a PI function. As useful as they can be, there is no require-
ment for you to ever use defined names. 

Entering Text and Numbers

Each cell in an Excel worksheet can be thought of as a miniature word processor. Text 
can be entered directly into the cell and then formatted in a variety of ways. To enter 
a text string, first select the cell where you want the text to appear and then begin 
typing. It is that simple.

Excel is smart enough to know the difference between numbers and text, so there are 
no extra steps for entering numbers. Let’s try the following example of entering num-
bers and text into the worksheet.

Select cell A1 and type: Microsoft Corporation Sales. In cell A2 enter: 
( Millions of Dollars). Select A3 and type: 2014 to 2019. Note that the 
entry in cell A3 will be treated as text by Excel because of the spaces and letters 
included. In cells A4 to F4, we now want to enter the years. In A4 type: 2019, in B4 
type: 2018, select A4:B4, and move the mouse pointer over the lower right corner of 
the selection. The mouse pointer will now change to a skinny cross indicating that 
you can use the AutoFill feature.4 Click and drag the mouse to the right to fill in the 
remaining years. Notice that the most recent data is entered at the left and the most 
distant data at the right. This convention allows us to easily recognize and concentrate 
on what is usually the most important data.

We have set up the headings for our first worksheet. Now let’s add Microsoft’s sales 
(in millions of dollars) for the years 2014 to 2019 into cells A5 to F5 as shown in 
Exhibit 1-1.

AutoFill Handle

4.  AutoFill can be used to fill any series that Excel can recognize. For example, type January in a cell and drag 

the AutoFill handle to automatically fill in month names. You can define your own series by clicking the Edit 

Custom Lists button under General in the Advanced category of Options.
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Formatting and Alignment Options

The worksheet in Exhibit 1-1 isn’t very attractive. Notice that the text is displayed at 
the left side of the cells, while the numbers are at the right. By default, this is the way 
that Excel aligns text and numbers. However, we can easily change the way that these 
entries are displayed through the use of the formatting and alignment options.

Before continuing, we should define a few typographical terms. A “typeface” is a par-
ticular style of drawing letters and numbers. For example, the main text of this book 
is set in the Times New Roman typeface. However, the text that you are expected to 
enter into a worksheet is displayed in the Courier New typeface. Typeface also 
refers to whether the text is drawn in bold, italics, or perhaps bold italics.

The term “type size” refers to the size of the typeface. We normally refer to the type 
size in “points.” Each point represents an increment of 1/72nd of an inch, so there 
are 72 points to the inch. A typeface printed at a 12-point size is larger than the same 
typeface printed at a size of 10 points.

Informally, we refer to the typeface and type size combination as a font. So when we 
say “change the font to 12-point bold Times New Roman,” it is understood that we are 
referring to a particular typeface (Times New Roman, bolded) and type size (12 points). 

For text entries, the term “format” refers to the typeface, size, text color, and cell align-
ment used to display the text. Let’s change the font of the text that was entered to 
Times New Roman, 12 points, bold. First, select the range A1:A3. Now, on the Home 
tab, click on the Font list so that the font choices are displayed and then select Times 
New Roman from the list. 

Next, click the Bold button and then choose 12 from the font size list. Notice that as 
you scroll through the Font and Size lists, the selected text is displayed as will look 
on the worksheet. This is known as Live Preview, and it works for many, but not all, 
of the formatting features in Excel. Because none of these changes actually take effect 
until you validate them by clicking, you can scroll through the choices until the text 

EXHIBIT 1-1
The First Worksheet

1

2

3

4

5

A B C D E F

Microsoft Corporation Sales

(Millions of Dollars)

2014 to 2019

2019 2018 2017 2016 2015 2014

125843 110360 89950 85320 93580 86833
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looks exactly right. You can also make these changes by right-clicking the selected 
cells and choosing Format Cells… from the menu. The choices that we made can be 
found on the Font tab.

We can just as easily change the font for numbers. Suppose that we want to change 
the years in cells A4:F4 to 12-point italic Times New Roman. First select the range 
A4:F4. Select the proper attributes from the Home tab, or right-click and choose 
Format Cells. Note that this change could also have been made at the same time as 
the text was changed, or you could now press Ctrl 1 Y to repeat the last action. You 
could also add the Repeat button to the Quick Access toolbar. Just click arrow at the 
right of the Quick Access toolbar and choose More Commands…. Now select the 
Repeat button and then click the Add button in the dialog box.

Our worksheet is now beginning to take on a nicer look, but it still isn’t quite right. 
We are used to seeing titles nicely centered over the table, but our title is way over 
at the left. We can remedy this by using Excel’s alignment options. Excel provides for 
seven different horizontal alignments within a cell. We can have the text (or numbers) 
aligned with the left or right sides of the cell or centered within the cell boundaries. 
Excel also allows centering text across a range of cells.

Let’s change the alignment of our year numbers first. Highlight cells A4:F4 and then 
click the Center button in the Alignment section of the Home tab. Notice that the 
numbers are all centered within their respective cells.

Next, we will center our table title across the whole range of numbers that we have 
entered. To do this, select the entire range across which we want to center our titles. 
Highlight cells A1:F3 and select Format Cells from the right-click menu. Click on the 
Alignment tab and then select “Center across selection” from the Horizontal alignment 
list. Click on the OK button and notice that the titles are indeed centered across col-
umns A to F. 

Be aware that there is also a button on the Home tab that will “Merge and Center” the 
selected cells. This button will have the appearance of doing the same thing as “Cen-
ter across selection,” but it doesn’t. In addition to centering the text, it also merges 
all of the selected cells into one big cell that spans multiple columns and/or rows. 
In the process of merging cells, all data that isn’t in the upper-left cell will be lost. 
Furthermore, merged cells make it difficult to select, sort, or filter a range. Generally 
speaking, it is better not to use the Merge and Center button. If needed, there is an 
Unmerge Cells command in the same button.

Formatting Numbers

Aside from changing the typeface and type size, when dealing with numbers we can 
also change their appearance by adding commas and dollar signs and by altering the 
number of decimal places displayed. Furthermore, we can make the numbers appear 
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differently depending on whether they are positive or negative. For example, we might 
want  negative numbers to be red in color and displayed in parentheses rather than using 
the negative sign. You can also experiment with designing custom number formats (see 
page 53), but for now we will stick to the more common predefined formats.

Microsoft is a large company, and its sales have ranged from nearly $70 billion to over 
$93 billion during 2014 to 2019. Numbers this large can be difficult to read unless they 
are written with commas separating every third digit. Let’s format our sales numbers 
so that they are easier to read. 

Select the range of sales numbers (A5:F5) and choose Format Cells from the right-
click menu and then click on the Number tab. You are presented with the Number 
Format dialog box, which contains a list of formatting categories. For now, select 
Number from the Category list. This will give you the option to choose the number of 
decimal places displayed, choose whether or not to use a 1000 separator, and select 
the format of negative numbers. We want to display the sales numbers with commas 
separating every third digit and two decimal places, so change the decimal places to 
2 and check the box to add a 1000 separator.5 Click on the OK button and notice that 
the numbers are now displayed in a more readable format. You could accomplish 
almost exactly the same format by clicking the Comma Style button on the Ribbon 
(there is a slight alignment difference between the two methods—you cannot center 
numbers formatted with the comma style).

We have made several formatting changes to the Microsoft Sales worksheet and yours 
should look like the one in Exhibit 1-2. All of this formatting may seem tedious at 
the moment, but it will become easy as you get more familiar with the choices. Fur-
thermore, the payoff will be worth far more than a few seconds spent formatting the 
worksheet.

5.  In the United States we use a comma as the 1000 separator. In many other countries a decimal point is used 

instead. Excel determines which to use based on settings in the Windows Control Panel.

EXHIBIT 1-2
Original Worksheet Reformatted

1

2

3

4

5

A B C D E F

Microsoft Corporation Sales

(Millions of Dollars)

2014 to 2019

2019 2018 2017 2016 2015 2014

125,843.00 110,360.00 89,950.00 85,320.00 93,580.00 86,833.00
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Adding Borders and Shading

Text formatting is not the only design element available in Excel. We can also liven 
up worksheets by placing borders around cells and shading them. In your worksheet, 
select A4:F4 (the years). Right-click the selection and choose Format Cells and then 
select the Border tab. There are 13 different line styles that can be applied, and you 
can change the color of the lines. Click on the thick solid line (fifth down on the right 
side) and then click on both of the top and bottom lines in the sample view. Click the 
OK button to see the change.

Next, with A4:F4 still selected, we will add shading. As before, choose Format Cells 
from the menu but this time select the Fill tab. Here you can set the background color 
and pattern of the cells. Choose a light gray color and press the OK button. Now, to 
make the numbers more readable, make them bold. Your worksheet should now look 
like the one in Exhibit 1-3.

None

Line

Style:

Color:

Automatic

EXHIBIT 1-3
The Worksheet with Borders and Shading

1

2

3

4

5

A B C D E F

Microsoft Corporation Sales

(Millions of Dollars)

2014 to 2019

2019 2018 2017 2016 2015 2014

125,843.00 110,360.00 89,950.00 85,320.00 93,580.00 86,833.00

Entering Formulas

So far, we haven’t done anything that couldn’t just as easily be done in a table in 
Microsoft Word. The real power of spreadsheets becomes obvious when formulas are 
used. Formulas will enable us to convert the data that we have entered into useful 
information.

At the moment, our sample worksheet contains only sales data for Microsoft. Suppose, 
however, that we are interested in performing an simple analysis of the profitability of 
Microsoft over the 2014 to 2019 time period. In this case, we would also need to see 
the net income for each of the years under study. Let’s make some modifications to 
the worksheet to make it more useful.

Add the data from Table 1-2 to the sample worksheet in cells A6:F6, immediately 
below the sales data, and apply the same formatting. Now, we have a couple of 
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problems. The title of our worksheet, in cell A1, is no longer accurate. We are now 
putting together a profitability analysis, so we should change the title to reflect this 
change of focus. Select cell A1 (even though the title is centered across A1:F1, Excel 
still keeps the data in A1) by clicking on it. Notice that the text appears in the right 
hand side of the formula bar. To edit the title, click on the formula bar just to the right 
of the word “Sales.” Backspace over the word “Sales” and then type:  Profitability 
Analysis, and press Enter to accept the change.

Our only remaining problem is that the data in the worksheet are not clearly identified. 
Ideally, we would like to have the data labeled in the column just to the left of the first 
data point. But, there is no column to the left of the data! There are several ways to 
overcome this problem. The easiest is to simply insert a column to the left of column 
A. To do this, select column A entirely by clicking on the column header where it has 
an “A.” Notice that the whole column is highlighted (we can do this with rows as well). 
Now, click the Insert button on the Home tab and choose Insert Sheet Columns. The 
new column is magically inserted, and all of our data have been moved one column to 
the right. In cell A5 type: Sales and in A6 type: Net Income.

If you are following the examples exactly, the words “Net Income” probably do not 
fit exactly into A6. Instead, part of the text is cut off so as not to overflow onto the 
data in B6. We can easily remedy this by changing the width of column A. Click the 
Format button on the Home tab and choose Column Width. In the edit box type: 20 
and press the Enter key. Column A should now be wide enough to hold the text that 
we have added and will add later.

We can now proceed with our profitability analysis. Because of the change in sales 
over the years, it isn’t immediately clear from the data whether Microsoft’s profitability 
has improved or not, because net income has varied as well. In this type of situation, 
it is often preferable to look at net income as a percentage of sales (the net profit 
margin) instead of dollar net income. Thankfully, we don’t have to type in more data 
to do this. Instead, we can let Excel calculate these percentages for us. All we need to 
do is to enter the formulas.

Insert

Format

Ta b l e  1 - 2 Microsoft Net Income 2014 to 2019

Year Net Income

2019 39,240.00

2018 16,571.00

2017 21,204.00

2016 16,798.00

2015 12,193.00

2014 22,074.00
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Formulas in Excel are based up on cell addresses. To add two cells together, we sim-
ply tell Excel to take the contents of the first cell and add it to the contents of the 
second. The result of the formula will be placed in the cell in which the formula is 
entered. In our problem, we need to find net income as a percentage of sales. We will 
do this first for 2019.

Before entering our first formula, we should insert a label identifying the data. In cell 
A7, type: Net Profit Margin. Change the active cell to B7 where we want to 
place the result of the calculation. The problem that we want to solve is to take the 
number in cell B6 (net income) and divide it by the number in B5 (sales). In Excel, 
division is represented by the forward slash (/), so in B7 type: 5 B6/B5. The equals 

sign must precede all formulas in Excel, otherwise it will treat the formula as text and 
will not calculate the result. Press the Enter key to calculate the result of the formula. 
You should get 0.3118 as the result.

In this example, we typed the formula directly into the cell because the small size of 
our worksheet made it easy to know what cells we wanted to use in the formula. In 
many instances, this is not the case. In more complicated worksheets, it is usually eas-
ier to use pointer mode to enter formulas. In pointer mode, we use the mouse to point 
to the cells that we want to be included, and Excel inserts them into the formula. 
Move to C7 and we will enter the formula using pointer mode. First, type 5 to place 
Excel in edit mode. Now, instead of typing C6, click on C6 with the mouse. Notice 
that C6 appears in the formula bar to the right of the equals sign. Press the forward 
slash key to indicate division and then click on C5. In the formula bar you should see 
the formula “5 C6/C5.” Press the Enter key to calculate the result of the formula. The 
result should be 0.1502. 

Let’s change the format of these cells so that they are easier to read. In this case, it 
would be nice to see them in percentage format with two decimal places. First, high-
light cells B7:C7. Right-click and choose Format Cells, and click on the Number tab. 
From the Category list, click on Percentage and then set the Decimal places to 2. 
Press the Enter key or click the OK button. You could also apply this format by using 
the Percent Style button on the Ribbon. To get two decimal places, you would then 
need to click the Increase Decimal button in the same group. Figure 1-7 shows these 
and other formatting icons.

.0
.00

FIGURE 1-7 Number Formatting Icons

Percentage

Number

,% .00
.0

.0
.00$
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Copying and Moving Formulas

We have now calculated the net profit margin for 2019 and 2018, but that still leaves 
four years for which we need to enter formulas. Repeatedly typing essentially the same 
formula can get tedious. Fortunately, we can simply copy the formula, and Excel will 
update the cell addresses to maintain the same relative relationships. For example, we 
know that for 2017 the formula should read “5D6/D5.” If we copy the formula from 
C7 to D7, Excel will change the formula from “5C6/C5” to “5D6/D5” automatically. 

This works because Excel treats all cell references as relative. When you typed the for-
mula in cell B7 (5B6/B5) Excel read that as “take the contents of the cell that is one row 
above the current cell and divide that by the contents of the cell that is two rows above 
the current cell.” When copying formulas, Excel maintains the same relative cell relation-
ships so that the formulas are updated. When we copy to the left or right, Excel updates 
the columns in the formulas. When we copy up or down, Excel changes the rows.

To change this behavior, we use absolute references instead. An absolute reference 
always refers to the same cell, no matter where you copy it. To create an absolute 
reference, type dollar signs before the column letter and row number. For example, 
$B$6 will always refer to cell B6. The “$” tells Excel to not change the reference. 
We can also create mixed references. In a mixed reference only the column or row 
remains constant, not both. For example, $B6 is a mixed reference (column absolute, 
row relative). If the formula is copied down, it will change to $B7, but if it is copied 
across it will still be $B6. On the other hand, B$6 (column relative, row absolute) will 
still be B$6 if copied down, but will change to C$6 if copied across. We will make 
heavy use of absolute and mixed references in later chapters. Note that you can use 
the F4 key (z 1 T on a Mac) to cycle through every possible reference type. Simply 
enter a cell address and repeatedly press F4 until you get the type of reference you 
need (e.g., $B$6, B$6, $B6, or B6).

Rather than retyping the formula for our other cells, let’s simply copy from C7. First, 
select C7 and then click the Copy button on the Ribbon (or Ctrl 1 C). Now highlight 
cells D7:G7 and click the Paste button. At this point, your worksheet should closely 
resemble the one in Exhibit 1-4. 

Copy

EXHIBIT 1-4
A Profitability Analysis for Microsoft

1

2

3

4

5

6

7

A B C D E F G

Microsoft Corporation Pro�tability Analysis

(Millions of Dollars)

2014 to 2019

2019 2018 2017 2016 2015 2014

Sales 125,843.00 110,360.00 89,950.00 85,320.00 93,580.00 86,833.00

Net Income 39,240.00 16,571.00 21,204.00 16,798.00 12,193.00 22,074.00

Net Pro�t Margin 31.18% 15.02% 23.57% 19.69% 13.03% 25.42%
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We can see from Exhibit 1-4 that Microsoft’s net profit margin has varied somewhat 
over this period, but the margins are quite high compared to those of many other 
companies.

In addition to copying formulas (which maintains the relative cell references), they 
can also be moved. Moving a formula to a different cell has no effect on the cell ref-
erences. For example, we could move the formula in B7 (5B6/B5) to B8. To do this, 
select B7 and then click the Cut button. Next, select B8 and then click Paste. Notice 
that the result in B8 is exactly the same as B7 because the formula is unchanged. Now 
click the Undo button on the Quick Access toolbar to return the formula to B7.

Formulas (or anything else) may also be moved with the mouse. Simply select the 
cells containing the data that you want to move, position the mouse pointer at the 
edge of the cell so that it changes to an arrow, and then click the left mouse button 
and drag the cell to its new location. Now move the formula back to B7. The work-
sheet should again resemble the one pictured in Exhibit 1-4.

Mathematical Operators

Aside from division, which we have already seen, there are four additional primary 
mathematical operations: addition, subtraction, multiplication, and exponentiation. 
Table 1-3 summarizes the five basic operations and the result that you should get 
from entering the example formula into cell B8. 

Cut

Ta b l e  1 - 3 Mathematical Operations

Operation Key Formula Result in B8

Addition 1 5B5 1 B6 165,083

Subtraction 2 5B5 2 B6 86,603

Multiplication * 5B5*B7 39,240

Division / 5B6/B7 125,843

Exponentiation ^ 515^2 225

Parentheses and the Order of Operations

Using the mathematical operators provided by Excel is straightforward in most 
instances. However, there are times when it gets a bit complicated. For example, 
let’s calculate the rates of growth of Microsoft’s sales and net income. To calculate 
the growth rates we usually want the compound annual growth rate (CAGR, which 
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is also known as the geometric mean growth rate) rather than the arithmetic average 
growth rate. 

The equation for the CAGR of sales is:

 CAGR 5 1N2 12ÅSalesN

Sales0

2 1 5 a SalesN

Sales0

b
1

(N2 1)
2 1 (1-1)

where N is the count of the numbers in the series, Sales0 is the first number in the 
series (2014 sales in our example), and SalesN is the last number in the series (2019 
sales).

Translating this equation into Excel is not as simple as it may at first appear. Doing 
this correctly requires knowledge of operator precedence. In other words, Excel 
doesn’t necessarily evaluate formulas from left to right. Instead, some operations are 
performed before others. Exponentiation is usually performed first. Multiplication and 
division are usually performed next, but they are considered equal in precedence so 
any multiplication and division are evaluated from left to right. Finally, addition and 
subtraction are evaluated and they are also considered equal in precedence to each 
other. These are the same rules that you learned in your first algebra class.

We can modify the order of operations by using parentheses. Operations enclosed in 
parentheses are always evaluated first. As a simple example, how would you evaluate 
the following expression?

X 5 2 1 4 / 3

Is X equal to 2 or 3.33? Algebraically, X is equal to 3.33 because the division should 
be performed before the addition as Excel would do. If the answer we were seeking 
was 2, we could rewrite the expression using parentheses to clarify:

X 5 (2 1 4) / 3

The parentheses clearly indicate that the addition should be performed first, so the 
answer is 2. When in doubt, always use parentheses because using them unnecessar-
ily will not cause any problems.

To calculate the compound annual growth rate of sales, move to cell A8 and 
type: Sales Growth. Now, enter the following into B8 using equation (1-1):  
5(B5/G5)^(1/5)21. Pressing the Enter key will reveal that the growth rate of sales 
for the five-year period was 7.70% per year (you may have to reformat the cell to dis-
play as a percentage with two decimal places). To determine the average growth rate 
of net income, type: Net Income Growth into A9, and copy the formula from B8 to 
B9. You should find that the compound annual rate of growth of net income has been 
12.19% per year and that the formula in B9 is: 5(B6/G6)^(1/5)21. Notice how 
the row references were updated when you copied the formula down.
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Using Excel’s Built-In Functions

We could build some pretty impressive worksheets with the techniques that we have 
examined so far. But why should we have to build all of our formulas from scratch, 
especially when some of them can be quite complex and therefore error-prone? Excel 
comes with hundreds of built-in functions, and more than 50 of them are financial 
functions. These functions are ready to go; all they need is for you to supply cell 
references as inputs. We will be demonstrating the use of many of these functions 
throughout the book, but for now let’s redo our growth rate calculations using the 
built-in functions.

Because we want to know the compound annual rate of growth, we can use Excel’s 
built-in GEOMEAN function.6 To use this function the syntax is:

GEOMEAN(Number1, Number2, …)

The GEOMEAN function takes up to 255 cell addresses (or ranges) separated by com-
mas. As is usual in Excel, we can also supply a range of cells rather than specifying 
the cells individually. Remember, we want to find the geometric mean rate of growth 

of sales (i.e., CAGR), not the geometric mean of the dollar amount of sales. Because 
the GEOMEAN function simply calculates the N th root of the product of the inputs, we 
need to redefine our inputs (we used the dollar amount of sales in our custom-built 
formula). Let’s add a row of percentage changes in sales to our worksheet (this is 
called a helper row).

Move to A10 and enter the label: % Change in Sales, then select B10 and enter 
the formula: 5B5/C521. The result in B10 should be 0.1403, indicating that sales 
increased by 14.03% from 2018 to 2019. Now copy the formula from B10 to each 
cell in the C10:F10 range. Note that we don’t copy the formula into G10 because that 
would cause an error since H10 doesn’t contain any data (try it, and you will see 
#DIV/0! in G10, meaning that your formula tried to divide by zero).

Now, to calculate the compound average annual rate of sales growth we need to enter 
the GEOMEAN function into B11: 5GEOMEAN(B10:F10). Because our data points are 
in one contiguous range, we chose to specify the range rather than each individual 
cell. Let’s also supply a label so that when we come back later we can recall what this 
cell represents. Move to A11 and enter: Sales Growth. 

Have you noticed any problems with the result of the GEOMEAN function? The result 
was a #NUM! error, rather than the 7.70% that we got when using our custom formula. 
Either our custom formula is incorrect or we have misused the GEOMEAN function. 

6.  We could calculate the arithmetic mean using the AVERAGE function, but this would ignore the compounding and 

overstate the true average growth rate. This function is defined as: AVERAGE(NUMBER1, NUMBER2, . . .).
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Actually, this type of error is common and easily overlooked. What has happened 
is that when using the GEOMEAN function, we didn’t fully understand what goes on 
behind the scenes. GEOMEAN simply takes the N th root of the product of the num-
bers. That single negative number has caused the entire product to be negative, and 
you can’t calculate a root of a negative number. What we should have done is calcu-
lated the geometric mean of the price relative changes (i.e., one plus the percentage 
change). 

To correct the error, replace the formula in B10 with: 5B5/C5 and copy it to the other 
cells. Now replace the formula in B11 with: 5GEOMEAN(B10:F10)21. The result is 
7.70%, exactly the same as our previous result. To avoid errors like this one, you must 
absolutely understand what the built-in formula is doing. Never blindly accept results 

just because Excel has calculated them for you. There is an old saying in computer 
science: “garbage in, garbage out.” 

At this point, your worksheet should closely resemble the one pictured in Exhibit 1-5.

EXHIBIT 1-5
Analysis of Microsoft’s Growth Rates

1

2

3

4

5

6

7

8

9

10

11

A B C D E F G

Microsoft Corporation Pro�tability Analysis

(Millions of Dollars)

2014 to 2019

2019 2018 2017 2016 2015 2014

Sales 125,843.00 110,360.00 89,950.00 85,320.00 93,580.00 86,833.00

Net Income 39,240.00 16,571.00 21,204.00 16,798.00 12,193.00 22,074.00

Net Pro�t Margin 31.18% 15.02% 23.57% 19.69% 13.03% 25.42%

Sales Growth 7.70%

Net Income Growth 12.19%

% Change in Sales 1.1403 1.2269 1.0543 0.9117 1.0777

Sales Growth 7.70%

Using the Insert Function Dialog Box

With the hundreds of built-in functions available in Excel, it can be difficult to remem-
ber the name of the one that you want to use or the order of the arguments. To help 
you with this problem, Excel provides the Insert Function dialog box, a series of 
dialog boxes that guide you through the process of selecting and entering a built-in 
formula.

Let’s use Insert Function to insert the GEOMEAN function into B11. First, select cell 
B11 and then clear the current formula by clicking the Clear button on the Home tab 
and then choosing Clear Contents (or, press the Delete key on the keyboard). Click 

Clear
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the Insert Function button on the Formulas tab to launch the first Insert Function 
dialog box. 

In the first dialog box click on Statistical in the “Or select a category” list. The “Select 
a function” list will now contain all of the built-in statistical functions. Scroll down 
this list and click on GEOMEAN. Notice that there is a definition of the function at the 
bottom of the dialog box. Click OK to go to the next dialog box, which is pictured in 
Figure 1-8.7

In the Function Arguments dialog box, you will see prompts and definitions for each 
of the inputs to the selected function. Click and drag the mouse over the B10:F10 
range. This range will appear in the “Number1” edit box. Click on the OK button to 
have the function entered. The result is 107.70%, not the 7.70% that we expected. We 
need to subtract 1 from the result of the function, so click in the Formula bar and type 
21 after the GEOMEAN function and then press Enter. The formula in B11 should be:  
5 GEOMEAN (B10:F10)21. Note that the 1 that we are subtracting represents 100% 
of the starting value.

Insert

Function

7.  Note that this dialog box frequently blocks your work. You can click and drag it out of the way.

FIGURE 1-8 The Excel 2019 Function Arguments Dialog Box

Function Arguments ?

GEOMEAN

Number1

Number1:

Number2

Formula result =

{1.14029539688293,1.226903835464...

number

number1,number2,... are 1 to 255 numbers or names, arrays, or
references that contain numbers for which you want the mean.

Returns the geometric mean of an array or range of positive numeric data.

=

=

=

Help on this function

B10:F10

1.077032606

1.077032606

OK Cancel

Insert Function is an easy way to discover new functions and to use familiar ones. 
You can also find functions by using the function category buttons on the Formulas 
tab. Choosing a function from one of those lists will lead to the same Function Argu-
ments dialog box. However you get there, using it will make Excel much easier for 
you to learn and use.
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If you know the name of the function that you need, you can skip the Insert Function 
dialog box. Just type 5 and then start typing the function name or any part of the 
name. Excel will automatically create a Formula AutoComplete menu listing functions 
that match what you have typed. Figure 1-9 shows the result from typing 5ge in a cell. 
You could also type 5mean or any other part of the function name to get a similar list.8

When you see the function name that you want, you can use the arrow keys to select 
it and then press the Tab key to begin entering the arguments. As you enter the func-
tion arguments, you will see a ToolTip that reminds you of their order.

8.  If you do not get the Formula AutoComplete menu when you start typing a function name then you will need to 

enable it in the options. On Windows, go to File, then Options, then Formulas and then check the box next to 

Formula AutoComplete. On Mac, the setting can be found in Excel Preferences AutoComplete.

FIGURE 1-9 Formula AutoComplete

GESTEP

GETPIVOTDATA

GEOMEAN

=ge

Array Functions

An array is a collection of values, such as the sales figures in B5:G5. An array  formula 

is a formula that operates on entire arrays at once and returns one or more values. 
These formulas are often helpful. They can make formula entry easier, avoid the need 
for helper rows/columns (such as row 10 in Exhibit 1-5), and can sometimes do 
things that are otherwise difficult or impossible to do with normal formulas. A few 
built-in functions return arrays. An example of these are the matrix algebra functions 
such as MMULT, TRANSPOSE, and so on that we will use in Chapter 14 (see page 463). 
In this section we will only look at a basic array formula, but in later chapters we will 
occasionally make use of more complicated array formulas.

Array formulas have been available in Excel for many years. However, in the Office 
365 version of Excel (as of late 2019) there is a new calculation engine that treats array 
formulas somewhat differently than before. In older versions, array formulas required 
that the user enter them using the Ctrl 1 Shift 1 Enter keystroke combination instead 
of just Enter. Furthermore, if the formula would return multiple values then the entire 
output range would need to be selected prior to entering the array formula.
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In the new calculation engine array formulas are handled automatically. There is no 
need for a magic keystroke combination to enter them, and if multiple values are 
returned they will spill over the range needed to contain the output. If the spill range 

is blocked by other content then you will receive a #SPILL! error. This can be reme-
died by rearranging your spreadsheet, altering the formula to return fewer values, or 
by using the TRANSPOSE function to change the direction that it spills.

As an example of an array formula, return to the worksheet that you created for 
Exhibit 1-5. When we used the GEOMEAN function to calculate the growth rate of sales 
in B11, we referenced B10:F10, which is a helper row. We needed that helper row 
because we had to add 1 to each percentage change in order for the GEOMEAN func-
tion to work properly.

Instead of using that helper row, we can use an array formula. Let’s build this for-
mula in stages. First, delete the values in B10:F10 and then select B10. Now type 
the array formula: 5B5:F5/C5:G5 and press Enter. The results should automatically 
spill across B10:F10. This formula takes each cell in B5:F5 and divides it by the cor-
responding cell in C5:G5, but it does it all in one step without the need to copy the 
formula across the output range. Notice that the values are exactly the same as before, 
and the GEOMEAN formula in B11 should return the same result as before.

Next, let’s eliminate the helper row. Delete the formula in B10. Notice that all of the 
values in B10:F10 are deleted because the formula that created them was entirely 
contained in B10, even though the values themselves spilled into the adjacent cells. 
In B11 type the array formula: 5GEOMEAN(B5:F5/C5:G5)21. You should get the 
same result as before, but without needing a helper row. Also notice that in this case 
the result was a single number, so there was no spilling into adjacent cells. If you 
wish, you can replace the formula in B8 with this formula, and then copy it down to 
B9 to calculate the growth rate of net income.

Array formulas can be confusing at first, but they can also be very powerful, and are 
therefore worth taking the time to learn. As previously mentioned, we will sometimes 
use array formulas in future chapters. If you are not yet using the most recent ver-
sion of Excel, you will have to enter them using the Ctrl 1 Shift 1 Enter keystroke 
combination.

“Dot Functions” in Excel

In Excel 2010, Microsoft introduced a new naming convention for some functions. 
The new functions contain a “dot” in their names. For example, the STDEV.S function 
calculates a sample standard deviation and is identical to the STDEV function that was 
in all earlier versions of Excel. In this case, the new naming convention is meant to 
more clearly convey the purpose of the function. In other cases, a dot function uses a 
new algorithm to calculate more precise results. 
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In all cases, the older versions of the functions are available for compatibility with 
older versions of Excel. If a file is created using the dot functions in Excel 2010 or 
later and then opened in Excel 2007 or earlier, the result will be a #NAME! error. That 
happens because older versions aren’t aware of the existence of new functions.

If a worksheet that you create may be used on older versions of Excel, you should run 
the Compatibility Checker before saving the file. This will warn of compatibility prob-
lems, including the use of the new dot functions. To use the Compatibility Checker, 
click the File tab and then Info. Click the Check for Issues button and then choose 
Check Compatibility. This will launch a dialog box like that shown in Figure 1-10, 
which is showing that there is a potential problem in Sheet1 of the workbook due to 
the use of functions that are incompatible with versions from Excel 97 to Excel 2007. 
Note that the dialog box shows the number of occurrences of each problem and the 
sheet on which they are located. If there is only one problem, then clicking the Find 
link will take you to that cell. If there is more than one problem then the easiest way 
to find them is by clicking the Copy to New Sheet button. This will create a new 
worksheet with a report that identifies each cell with a problem, including a hyper-
link that will take you straight to that cell.

Check for

Issues

FIGURE 1-10 The Compatibility Checker

Microsoft Excel - Compatibility Checker ?

If the workbook is saved in an earlier format or opened in an earlier version
of Microsoft Excel, the listed features will not be available.

Summary Occurrences

One or more functions in this workbook are not available in
earlier versions of Excel. When recalculated in earlier
versions, these functions will return a #NAME? error instead
of their current results.
Location: ‘Sheet1’

1

Excel 97-2003

Excel 2007

Find Help

Check compatibility when saving this workbook.

Significant loss of functionality

Copy to New Sheet

Select versions to show

OK
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Using User-Defined Functions

There are times when you need to calculate a complex formula and Excel doesn’t have 
a built-in function that will do the job. In this case, you can either type the formula 
into a cell (which can be very tedious) or use a user-defined function. A user-defined 

function is similar to a built-in function, except that it was created by somebody 
other than the Excel development team at Microsoft. User-defined functions can be 
purchased, downloaded from the Internet, or you can create your own. Writing them 
in Excel’s macro language (Visual Basic for Applications, see Chapter 15) is beyond 
the scope of this chapter, but we have included several functions in the FameFncs.
xlam file, which can be found on the official Web site for this book.9 Download 
the file and save it in an easy-to-remember location. These functions will be used 
occasionally throughout the book, especially in later chapters.

Before using a user-defined function you must open FameFncs.xlam. This file is a 
special type of Excel file known as an add-in. An add-in can be opened just like 
any other Excel file, or it can be set to open automatically every time you start Excel. 
To make the functions in this file available at all times, click the File tab and then 
Options. Click Add-ins and then choose Excel Add-ins from the Manage list and click 
the Go button. This will open the Add-ins dialog box as pictured in Figure 1-11. If 
you have enabled the Developer tab, then you can also click the Excel Add-ins button 
located in the Add-ins group.

Excel

Add-ins

9.  In Excel 2007 and later, file names with extensions that are .xlsm or .xlam contain macros. These files may 

require special security settings before Excel will allow the macros to run. Go to the File tab, then Options, and 

set up your Trusted Locations in the Trust Center. You may still receive warnings for some files, but if you are 

sure that they are safe then allow the macros to run.

FIGURE 1-11 The Add-ins Dialog Box

Add-ins ?

Add-ins available:

Functions for Financial Analysis

Analysis ToolPak
Analysis ToolPak - VBA
Covariance Matrix Builder 2.0
Euro Currency Tools
ExcelSim 2019
Functions for Financial Analysis
Solver Add-in

This add-in contains functions for use with the book Financial
Analysis with Microsoft Excel, 9th Edition.

OK

Cancel

Browse...

Automation...
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Click the Browse button, navigate to where you saved the file, and choose FameFncs.
xlam. It will be added to the Add-ins dialog box as shown above, and the functions 
in the file will now be available to use in all of your workbooks. If you can’t access 
the functions, be sure that you saved the file in one of your trusted locations as men-
tioned in footnote 9.

Using a user-defined function is almost exactly the same as using a built-in function. 
The only difference is that the file containing the functions must be opened in order 
for the functions to be known to Excel. You can even use the Insert Function dialog 
box (select the User Defined function category, which is only available when user-
defined functions are installed).

As an example of the use of user-defined functions, we have created one to calculate 
the compound average annual rate of growth of sales from the dollar amounts instead 
of the price relatives that we used earlier. The function is defined as10:

FAME_CAGR(SALES)

FAME_CAGR is the name of the function, and SALES is the required range of cells that 
contain the sales figures. The function automatically calculates the formula given in 
equation (1-1) on page 20.

Now, in your original worksheet, select cell B12 and then bring up the Insert 
Function dialog box. Choose the User Defined category to display the list of 
functions that were supplied with this book. In the “Select a function” list, 
select FAME_CAGR and then click the OK button. In the edit box for Sales enter 
B5:G5, which is the range that contains Microsoft’s sales. Click on the OK button 
and see that the answer is exactly the same as before. The function in B12 is: 
5FAME_CAGR(B5:G5). 

We will use more of the user-defined functions from this add-in in later chapters.

Creating Graphics

In our simple profitability analysis, it is obvious that Microsoft’s profit margins have 
been somewhat volatile over the last six years. Many times, you will build much more 
complicated worksheets where the key trends are not so easy to spot, especially by 
others who haven’t spent as much time with the data. You may also find that you 

10.  This function was written specifically to calculate a compound average growth rate from dollar values. It does 

not duplicate Excel’s GEOMEAN function, so do not use it in place of that function.
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need to give a presentation, perhaps to a group of investors to convince them to 
invest in your firm. In cases such as these, tables full of numbers may actually obscure 
your point. People (and students too!) tend to get a glazed look in their eyes when 
examining tables of numbers. The solution to this problem is to present a chart of the 
numbers to illustrate your point. Fortunately, high-quality graphics are a snap with 
Excel.

There are three ways that charts can be created in Excel: in separate chart sheets, 
embedded in the worksheet, or as in-cell charts known as Sparklines. We will cover 
each of these methods in turn.

Creating Charts in a Chart Sheet

When you want to focus only on a chart, then it is best to create it in its own chart 
sheet. We can create a chart separate from the worksheet by selecting the data and 
inserting a new chart sheet. Let’s try creating a graph of Sales versus Net Income for 
Microsoft.

First select the data in the A4:G6 range and then right-click the tab for the current 
worksheet. From the menu that appears, choose Insert. You will now be presented 
with a list of different file types from which to select. Because we want to create a 
chart, select Chart from the list and press Enter or click OK. 

A chart sheet will open with your data displayed automatically in a Column chart. It 
will have a default chart title, no axis titles, and will require a few other enhancements. 
Note that you now have two additional tabs in the Ribbon (Chart Design and Format) 
that are specific to working with charts. These are known as contextual tabs because 
they only appear when editing a chart. If you want another type of chart, click the 
Change Chart Type button on the Chart Design tab.

Let’s begin to fix our chart by adding a title. Select the chart and then click the Chart 
Elements button that appears near the upper-right corner of the chart (Microsoft calls 
these buttons the Proximal UI). Click the Chart Title item and choose the Centered 
Overlay option. In the text box that appears, type: Microsoft Sales vs. Net 
Income and then click outside the box to lock in the title. 

You will follow a similar procedure for the axis titles. Click the Axis Titles item in the 
Chart Elements button to insert both the x and y axis titles. For the x-axis double click 
the “Axis Text” label and then type: Years, and for the y-axis type: Millions of 
Dollars for the title. Your chart should now resemble the one in Exhibit 1-6. We will 
see how to fix the reversed x-axis after the next section.

Chart

Change
Chart Type

Chart
Elements

Chart
Styles

Chart
Filters
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Creating Embedded Charts

You may want to create a chart that will be saved and displayed within the worksheet 
itself. Such a chart is referred to as an “embedded chart” because it appears within 
the worksheet. Unlike a separate chart sheet, embedded charts can be displayed and 
printed on the same page as the worksheet data. If necessary, embedded charts can 
be printed separately from the worksheet.

To create an embedded chart, first switch to your worksheet. Now select A4:G6 as 
before and then click the Insert tab. Click the Column button in the Charts group and 
then choose the first type listed under 2-D Column. The chart will appear in the mid-
dle of your worksheet. To resize the chart, click and drag any of the selection boxes 
on its perimeter. To move the chart, click on a blank area inside the chart and drag 
it to wherever you want it to be. If you hold down the Alt button (z on Mac) while 
dragging or resizing the chart, it will snap to the gridlines. Your worksheet should 
now resemble the one in Exhibit 1-7, except for some minor formatting changes. 
Enter the chart and axis titles exactly as before.

Note that you can move your embedded chart into a separate chart sheet and vice 
versa. Just right-click in the chart and choose Move Chart from the shortcut menu. 
There is also a Move Chart button on the Chart Design tab. You can even move your 
chart to a different worksheet in this way.

Move

Chart

EXHIBIT 1-6
A Stand-Alone Chart
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Formatting Charts

We have now created a basic chart of Sales versus Net Income, but it probably isn’t 
quite what you expected. First of all, we normally expect that the most recent data in 
a chart is on the right side and the oldest on the left. Because we have created our 
worksheet data in the opposite direction (a common convention), our chart is back-
ward and a quick glance might suggest that sales and profits have been declining.

In Excel, every element of a chart is treated as a separate “object.” This means that 
each element can be selected and edited separately from the other elements. In 
addition, these chart objects are somewhat intelligent. They “know” what actions can 
be performed on them and will present a menu of these actions if you right-click 
on them. The major objects in any chart include each data series, the plot area, the 
gridlines, the axes, each axis title, the chart title, and any text boxes entered into the 
chart. To select an object, all that you need to do is to click on it. Once the object is 
selected, it will have small squares (selection handles) surrounding it. In some cases 
this will result in the selection of multiple items (e.g., the entire data series, or the 
entire legend), but you can often narrow the selection with a second click (not a 
double-click). With this knowledge, let’s edit our chart.

EXHIBIT 1-7
A Worksheet with an Embedded Chart
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First, we want to turn the x-axis around so that the data are presented in the order that 
we normally expect. Right-click on the x-axis (or the axis labels) to show the shortcut 
menu. Once the menu appears, choose Format Axis. This will launch the Format Axis 
panel on the right side of the window. Under Axis Options, choose the Date Axis type 
so that Excel understands that our year numbers are dates. It will flip the axis so that 
it reads left to right as we would expect. If we had entered full dates in the heading 
(e.g., 6/30/2019), then Excel would have recognized the dates and created a date axis 
that we wouldn’t need to flip.

We could also flip the axis by selecting “Categories in reverse order” from the same 
panel. This will reverse the x-axis, but also move the y-axis to the right side of the 
chart. If that isn’t what you want, click on “At maximum category” in the same dialog 
box to move the y-axis back to the left side. This method is best used when your 
x-axis labels are text. If they are dates, then the previous method is better.

Now suppose that we wanted to change the chart title so that it shows the years that 
are covered by the data. Simply click on the chart title to select it, then click at the 
end of the title. You could begin typing immediately, but we want to put the new text 
on a second line. Press Enter to begin a new line and then type: 2014 to 2019 and 
press the Esc key or click anywhere else on the chart. You may need to resize the font 
to make the title fit.

Next, let’s move the legend to the bottom of the chart to see if it looks better there. 
Right-click on the legend and choose Format Legend from the shortcut menu. Select 
Bottom from the choices presented. Close the Format Legend panel and return to the 
chart. If things don’t look quite right, click in the plot area to select it and drag the 
selection handles until the plot area is the proper size. Your worksheet should now 
resemble the one in Exhibit 1-8.

Changing the Chart Type

Excel offers many different types of charts: everything from the column chart that 
we have created to Box and Whisker charts and Waterfall charts. Some of these chart 
types are very sophisticated. Despite potential complexities, changing the chart type 
is very simple. 

Let’s assume that we would prefer to see the data in our chart presented as two lines, 
rather than as columns. To make this change, right-click anywhere inside the chart 
and choose Change Chart Type from the menu (or the button on the Chart Design 
tab). Select a Line chart and click OK. The chart is now displayed as a line chart. You 
can even change the type of an individual data series. For example, you might want 
to see Sales as a Column chart and Net Income as a Line on the same chart. Give it 
a try. Right-click on the Sales data series, choose “Change Series Chart Type…” and 
change the chart type to Clustered Column. 

Change
Chart Type
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Another option would be to create an XY Scatter chart, where each point represents 
an (X,Y) coordinate. This type of chart would be more appropriate for our data 
because the x-axis data (the years) is numerical, and it would also eliminate the need 
to flip the x-axis. Column and Line charts are best suited to categorical data, and Scat-
ter charts are best for numerical data. One exception is when you have dates as the 
x-axis data. As we saw, Line and Column charts allow for a date axis that gives great 
flexibility. Figure 1-12 shows the Scatter chart.

EXHIBIT 1-8
Worksheet with Reformatted Chart
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FIGURE 1-12 Sales vs. Net Income as a Scatter Chart
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You can also change other formatting in the chart very easily. Excel has many built-in 
chart styles, and you can choose one from the Chart Styles button next to the chart 
(or the Chart Styles group on the Chart Design tab). These styles were created with 
complimentary colors so that they look nice, even if you don’t have any design skills. 

If you want to change just the color of the columns (or line) for Sales, simply right-
click on one of the data points and choose Format Data Series. Click the Fill & Line 
button and then Solid Fill. You can now choose the exact color that you want to apply 
to the data series. You can also change the border around the bars and add a shadow 
for a three-dimensional effect. 

Be careful about applying too much “eye candy.” Excel’s charting ability makes it easy 
to fill the chart with effects that add nothing to the viewer’s understanding of the data. 
Typically, excessive formatting distracts from the message of the chart (e.g., see just 
about any so-called infographic on the Internet). Excel charting and data visualization 
experts11 generally recommend that you use the correct type of chart and keep the 
formatting as simple as possible. After all, the purpose of a chart is to make data eas-
ier to understand; it isn’t supposed to be a work of art.

Creating Sparkline Charts

Sparklines are a type of “word” chart created by Edward Tufte, a statistician and data 
visualization expert. They are tiny charts that are intended to be presented as a “word” 
in a line of text or next to data in a table. Their chief purpose is to display trends and 
variability in a very compact space.

Let’s add a few sparklines to our worksheet to show the trend in sales, net income, 
and net profit margin over time. Select cell H5 and then click the Insert tab and 
choose the Line button in the Sparklines group. In the dialog box choose B5:G5 as 
the Data Range and then click OK.

You will now have the sparkline chart in H5, but notice that it seems to indicate that 
sales have been declining. As before, this is because our data is listed from newest to 
oldest so we need to flip the x-axis. On the Design tab for the sparkline, click the Axis 
button and choose Plot Data Right-to-left. Now we can easily see, in a very compact 
space, that sales have been mostly trending upward for the last six years.

You can follow the same steps to create sparklines for net income and the net profit 
margin, or you can simply use the AutoFill handle to copy the sparkline from H5. 

Line

Axis

11.  For example, see Jon Peltier, an Excel charting expert who maintains the PTS blog at https://peltiertech.com. 

Stephen Few is a data visualization expert and author who maintains the Visual Business Intelligence blog at 

https://www.perceptualedge.com/blog.
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We can now apply additional formatting, such as adding markers to each data point 
by making use of the options available on the Sparkline tab. 

EXHIBIT 1-9
Profitability Analysis with Sparklines
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If you want to change the type of Sparkline chart, simply select the Sparklines and 
then click the type of chart that you want in the Sparkline tab. Note that you cannot 
delete Sparklines by pressing the Delete key. Instead, click the Clear button in the 
Sparkline tab, or right-click them and delete them using the shortcut menu.

Printing

There are many times when a worksheet displayed on screen accomplishes all that 
you need. Other times there is no escaping the need for a printed copy. Excel makes 
printing a worksheet both easy and flexible. For small worksheets all that needs to be 
done is to click the File tab, and then on the Print tab click the Print button. This will 
print the worksheet immediately, using the default printer and settings. Note that the 
preview of the printout is shown in this tab instead of a separate window as in older 
versions of Excel. 

Larger printing tasks are only slightly more complex. Suppose that our profitability 
analysis of Microsoft needs to be printed so that it can be distributed at a meeting. As 
a first step, we need to decide if we want to print the entire worksheet or only a por-
tion of it. In this case, let’s assume that we wish to print the whole worksheet, except 
that we want to print the graph on a separate page so that it can more easily be con-
verted to an overhead transparency.

Because we wish to print the numbers and chart separately, we need to tell Excel the 
range of cells that we want printed. Select the range A1:G11, choose Print Area on the 
Page Layout tab, and then Set Print Area. Notice that a light gray line now surrounds 
the range that we have selected for printing. Before actually printing a worksheet, it 
is good practice to preview the output to make sure that it looks exactly as we want. 

Clear

Print

Print

Area
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This will save both time and paper. From the File tab choose the Print tab. Excel will 
now display a likeness of the actual printed page. If it doesn’t look exactly the way 
that you want, you can change some options. For example, if the gridlines appear on 
the print preview, you can turn them off on the Page Layout tab by unchecking the 
Print option under Gridlines.

If you have followed the examples to this point, you might, depending on the type 
of printer you are using and the font size, notice that our worksheet is too wide to fit 
on one page. Because we would ideally like to fit the whole worksheet on one page, 
we have some adjustments to make. Essentially we have two options: either change 
the page orientation to print sideways (i.e., landscape mode) or have Excel reduce the 
printout to fit on one page. Each of these methods is equally viable, but let’s go for 
the reduction to one page.

From the Print tab, we can click the button that shows the current scaling choice (prob-
ably No Scaling) and choose an option from the list. You can also set custom scaling 
options by clicking the Page Setup link, which will launch the Page Setup dialog box. 
In the Fit to: __ pages wide by __ tall and enter a 1 in both boxes. We also don’t want 
the gridlines to print. Click on the Sheet tab and make sure that the Gridlines option is 
deselected (no check mark in the box). Click OK to return to Print Preview.

At this point, everything should be ready for printing, so click on the Print button. 
Excel now returns to the normal view and presents you with the print dialog box. 
Because we want to print the whole range that we have selected, make sure your 
printer is ready (turned on, has paper, etc.) and click OK. Your page should look 
nearly identical to the on-screen version.

To print the chart on a separate page, we first need to click on it so that it is selected. 
Now, to print the chart simply select Print from the File tab. Presto! The chart prints 
out on its own page. Of course, you will still see the Print Preview and be able to use 
the page setup options for charts just as we did for the worksheet.

What if you wanted to print the chart on the same page as the worksheet? Simple, 
just select the entire range that you want to print, including the chart. Now repeat the 
steps from above (resetting the print area), and the worksheet and chart will print on 
the same page. An easier alternative is to select the range to print, choose Print from 
the File tab, and make sure that Print Selection is selected in the Settings section.

Using Excel with Other Applications

Suppose that you are writing a report on the profitability of Microsoft for the past 
six years. Chances are good that you are writing the report in one of the major word 
processing programs. Your word processor probably allows for the creation of tables 
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that can display all of the information that you have created in Excel, but it lacks the 
computational sophistication and graphics power of Excel. Similarly, Excel lacks the 
text processing power that you need to write the report. Fortunately, it is very easy to 
harness the strengths of both programs and combine the results.

While some word processors will read Excel files directly from your disk, this is not 
usually the easiest way to incorporate spreadsheets into your word processing files. 
Instead, it is usually easiest to use some variant of copy and paste, just like we’ve used 
within Excel itself. Every time you copy data from Excel, it goes to the clipboard. The 
contents of the clipboard are available to any other application that cares to access 
them. All you need to do is copy the data from within Excel, switch to the other appli-
cation, and then paste from its menus.

Simply pasting the Excel data into a word processor may result in the word processor 
reading the data and creating a table. While this may be all that you need, many times 
it would be more convenient if you could still edit the data in its native environment. 
In other words, it would be nice if you could still take advantage of Excel’s built-in 
functions and recalculation ability. You can. Instead of using the paste command, use 
Paste Special. 

The Paste Special command allows much more freedom in how the data is stored 
inside the word processor. For example, if you choose to paste the data as a 
“Microsoft Excel Worksheet Object” you will be able to edit the data from within 
the word processor by simply double-clicking on it. If you are using Microsoft Word, 
the Ribbon will change to that of Excel, and you can edit the data exactly as if you 
were in Excel. 

Alternatively, you can link the data to your worksheet so that when you make changes 
in Excel, they are automatically reflected in your word processor. Finally, you can 
paste a noneditable picture of your data into your document. Either of these last two 
methods will consume less memory than embedding the worksheet.

Quitting Excel

In previous versions, you could exit from Excel by selecting Exit from the File tab. 
However, due to user confusion between closing files and exiting, this option was 
eliminated in Excel 2010. Now to close the workbook and exit you must repeatedly 
click the Close button in the upper right corner of the Excel window to close each 
open workbook and eventually the program itself. Note that if you attempt to close a 
file without saving your work, Excel will warn you and ask if you would like to save 
the file.
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